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CHAPTER 1 INTRODUCTION

Through its National Center for Transit Research (NCTR), and under contract with the Florida
Department of Transportation (FDOT), the Center for Urban Transportation (CUTR) was tasked to
undertake a continued sampled review of bus transit accidents at selected Florida public transit systems.
The purpose of this review is to analyze the change in accident data over time. The goal of the project is
to show transit systems, through demonstration, the simplicity by which accident data can be analyzed,
how to use the data to identify the success of safety campaigns, and how a small investment in analyses
might have a great impact on reducing transit accidents, thereby lowering operating costs and insurance
premiums. Through this research exercise transit systems in Florida will be more likely to analyze their
data and reduce transit accidents at their property.

It is important to note that this evaluation is a follow up study to 1999 Florida Department of
Transportation Research Idea project entitled “System Safety Program and Accident Tracking Analysis”
as well as the “Analysis of Florida Transit Bus Crashes” project completed in 2001. This project follows-
up on the recommendations of those reports. The expectation of this project is to enable small and
medium size agencies to track accident occurrences and trends and measure the effectiveness of safety
campaigns.

1.1 Case Study Selection Process

CUTR commenced its investigation by researching medium Florida transit systems that had some type of
safety program in place over the last couple of years. For this project, a safety program will be defined as
a system-wide operator training that has been implemented to promote safety and reduce the number of
accidents within a system.

After an initial evaluation of Florida’s medium transit systems, and with guidance from FDOT, four
systems were ultimately selected for this investigation: Gainesville Regional Transit System (RTS) in
Gainesville; Sarasota County Transportation Authority (SCAT) in Sarasota; County of Volusia, dba
VOTRAN in Daytona Beach and Lee County Regional Transit System (LeeTran) in Fort Myers. This
reports documents the case study analysis of safety programs and accident tracking and analysis at RTS,
SCAT, VOTRAN, and LeeTran.

1.2 Analysis Methodology

To begin the analysis of the safety program, the systems were contacted to discuss the project and scope
and goals, encourage participation and identify a primary contact person for subsequent communication,
information requests, and questions. Meetings were held with agency representatives at the outset of the
effort to help establish data requirements for the evaluation.



Following initial contact, CUTR staff worked with system contacts to collect information regarding their
safety program, and accident data for a minimum period of 24 months were collected from system records
and analyzed. After retrieval of the appropriate occurrence data, Microsoft Excel was utilized to sort the
data and arrange it into a format suitable for analysis. The data collection effort was geared to ensure that
each accident data record included the following variables: date, time of day, day of week, preventability
status, location, vehicle number, route number; years of experience of the operator, weather conditions;
and type of impact dynamics. The results of these analyses for each case study transit system are
described in the following sections.

Also, provided in this report is a user friendly database and analysis tool that has been developed in
Microsoft Access to help medium size transit systems to collect and analyze data . The database includes
the variables collected in this project along with some additional variables such as: year and manufacturer
of the vehicle, post accident testing and date of last training and type of training.

It should be noted that the following definitions apply for this project and it documentation. An accident
is defined as a collision with another vehicle, pedestrian or fixed object and occurs when there is physical
contact between the bus and another vehicle, pedestrian or fixed object. An incident is defined as an
occurrence which can take place on the vehicle or without any contact with another vehicle (i.e., a
passenger falls on the bus.) This study will focus on bus accidents.



CHAPTER 2 GAINESVILLE REGIONAL TRANSIT SYSTEM

The City of Gainesville located in Alachua County, Florida ranked 21% out of 67 counties in Florida with
an estimated population of 223,578 people according to the 2003 United States Census population
estimates. The 2003 population of Gainesville was approximately 117,182 people (52 percent of the
county population). In addition to being the largest municipality in the county, Gainesville is also home
to the oldest and largest university in the State of Florida, the University of Florida (UF) in 2004, Fall
Semester enrollment at UF was approximately 48,000 students.

The Gainesville Regional Transit System (RTS) was established in 1975, and operated as a small urban
transit system. Up until 1997, RTS was experiencing declining transit ridership and community support.
This situation changed when Gainesville and the University of Florida entered into a partnership to allow
student access to the RTS system. The University of Florida pays a student services fee to Gainesville,
based on the number of student credit hours in a semester. Students can then ride RTS (free) by showing
their student ID.

The current RTS system operates as a pulsed network, focused on the downtown city plaza and the UF
transportation hub. According to the 2002 National Transit Database (NTD), the RTS service area is
approximately 73 square miles, with a service area population of 140,000. The service area population
fluctuates substantially during the year due to the incoming and outgoing student population. Fixed route
service is provided 7 days a week (with reduced service on the weekends) and with a fleet of 85 directly
operated buses. In 2002, over 7 million unlinked trips were made on RTS. This was an increase of 14
percent over the 2001 ridership figure. Growth in RTS ridership is illustrated in Figure 2.1

2.1 RTS Academy

The RTS Academy is a department within RTS tasked with bus training operators in a variety of
components of bus driving and operations. The Academy is managed by one training supervisor
(certified by the Transportation Safety Institute). The RTS Academy commenced training programs in
the mid 1990’s. All new operators (whether experienced or not) joining RTS are expected to complete
the course at the Academy. Bus operators completing training in the RTS Academy have achieved a 98
percent success rate earning their Commercial Drivers License (CDL).



Figure 2.1
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2.2 RTS Safety Programs

All operators joining RTS must complete an initial training program (6 weeks in duration), which
assumes operators have no commercial driving background. Operators with a CDL usually can complete
the course in approximately four weeks.

Following initial training, RTS requires operators to complete yearly “refresher” training. The refresher
training course is offered during the summer months. These courses target the driving behavior and
knowledge of senior operators but all RTS operators are expected to participate in the program. Eighty-six
RTS bus operators participated in the 2002 summer refresher course. The primary facilitator of the
course is the RTS training supervisor, but outside experts are invited to participate in the teaching of
specialized subject areas. Each course lasts approximately 40 hours and updates operators on new routes,
new driving techniques, hours of service and defensive driving techniques. Gainesville offers a ‘Bicycle
Friendly’ environment, and one of the components of the refresher courses is to train and update operators
in bicycle safety techniques and awareness. In this study, the summer training program took place during
the months of June and July 2002. Curriculum details of the program are presented in Table 2.1

2.3 Accident Database

RTS records all accidents which involve their buses, even when a third party may have been involved.
Through such data collection, basic accident statistics are captured and are subsequently used as



number of accidents.

Table 2.1

management information. In-depth statistical analysis of the data was not performed due to the low

RTS Academy Summer Training Course — June and July 2002

Class Description Time

Farebox 8:00 —9:00 AM

GPD 9:00—11:30 AM
Lunch 11:30 AM - 12:30 PM
Adult CPR 12:30 — 5:00 PM

Pre and Post Trip 8:00 — 10:00 AM

Day on the Range 10:00 AM - 12:00 PM
Lunch 12:00 — 1:00 PM

Day on the Range Cont 1:00 - 5:00 PM
Common Problems 8:00 - 10:00 AM
Bicycle Accident Prevention 10:00 AM-12:00 PM
Lunch 12:00 — 1:00 PM

RTS Rules / Handbook 1:00 — 5:00 PM
Americans with Disabilities Act ADA Regulations 8:00-9:00 AM
Disability and Sensitivity 9:00—-11:30 AM
Lunch 11:30 AM - 12:30 PM
Customer Service 12:30 - 5:00 PM
Preparing for The Fall 8:00 - 9:00 AM

Drugs and Alcohol 9:00—11:30 AM
Lunch 11:30 AM-12:30 PM
Use of Radio 12:30 - 2:30 PM

Most Common Accidents 2:30-5:00 PM

2.4 Accident Analysis

Accident data used in this study were obtained from RTS office in Gainesville. RTS staff collected and
prepared the records, while CUTR staff captured and analyzed the data in Microsoft Excel. Any
questions regarding clarification of records were answered by RTS staff.

2.5  Analysis Period

Safety refresher programs are conducted at RTS during the summer months. This is also the period where
ridership is at its lowest when most students are away from the UF campus. Accident records were used
for the 12 preceding and 12 months after the Safety Training course (taking place in June and July 2002).
Thus, the total analysis time frame was from June 2001 to July 2003 (26 months).



2.6 General Occurrence Characteristics

The number of accidents that occurred during the 26 month period of June 2001 through July 2003 is
presented in Table 2.2 and Figure 2.2. Column 2 of Table 2.2 presents the number of accidents per
month. The percentage distribution of these accidents is determined by the monthly accidents divided by
the total number of accidents in the study period. Average accident frequency (per month) is derived by
the number of accidents in a specific month, divided by the number of years for which those monthly
accidents totals were submitted.

Table 2.2
Combined Frequency Distribution of Monthly Accidents
Month Number % Distribution Average Frequency Years of Data
January 8 10.4 4.0 2
February 3 3.9 1.5 2
March 8 10.4 4.0 2
April 7 9.1 3.5 2
May 3 39 1.5 2
June 7 9.1 2.3 3
July 9 11.7 3.0 3
August 4 52 2.0 2
September 10 13.0 5.0 2
October 10 13.0 5.0 2
November 1 1.3 0.5 2
December 7 9.1 3.5 2
Total 77 100.0

September and October experienced the highest number of accidents (based on average frequency).
These two months were followed by January, March, December, April and July. The months with the
lowest average frequency of accidents are November, February and May.



Figure 2.2
Combined Frequency Distribution of Monthly Accidents
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2.6.1 Accident Occurrence by Day of Week

Crash occurrence data by day of week is presented in Table 2.3 and in Figure 2.3. Table 2.3 presents data
accident frequency by day of week. Overall, Tuesdays and Wednesdays were the days with the highest
numbers of accidents. These two days were the days with the highest overall daily accident frequency
(based on dividing the number of accidents occurring on a Monday by the number of Mondays in the
study period). Reduced Sunday bus operation and less traffic may account for the significantly lower
numbers of accidents occurring on this day.

Table 2.3
Combined Frequency Distribution of Day of Week Accidents
Day of Week Frequency % Distribution JAverage Frequency] Days
Sunday 2 2.6 0.02 113
Monday 14 18.2 0.12 113
Tuesday 20 26.0 0.18 113
Wednesday 18 23.4 0.16 113
Thursday 5 6.5 0.04 113
Friday 13 16.9 0.12 113
Saturday 5 6.5 0.04 113
Total 7 100.0 0.10 791




Figure 2.3
Combined Frequency Distribution of Day of Week Accidents
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2.6.2  Accident Occurrence by Time of Day

Table 2.4 and Figure 2.4 present data on accident occurrence for various times of day that accidents
occurred. The time periods with the highest number of accidents are between 2:00 p.m. - 2:59 p.m. and
4:00 p.m. - 4:59 p.m. The second busiest period for accident occurrence was during the off-peak period
between 11:00 a.m.-11:59 a.m.

Table 2.4
Combined Frequency Distribution by Time of Day Accidents
Time of Day Frequency | % Distribution Time of Day Frequency | % Distribution
6:00 a.m. to 6:59a.m. 0 0.0% 4 :00 p.m. to 4:59 p.m. 9 11.7%
7:00 a.m. to 7:59a.m. 3 3.9% 5:00 p.m. to 5:59 p.m. 6 7.8%
8:00 a.m. to 8:59a.m. 1 1.3% 6:00 p.m. to 6:59 p.m. 5 6.5%
9:00a.m. to 9:59a.m 6 7.8% 7:00 p.m. to 7:59 p.m. 2 2.6%
10:00 a.m. to 10:59 a.m. 3 3.9% 8:00 p.m. to 8:59 p.m. 0 0.0%
11:00 a.m. to 11:59a.m. 8 10.4% 9:00 p.m. to 9:59 p.m. 4 52%
12:00 p.m. to 12:59p.m. 6 7.8% 10:00 p.m. to 10:59 p.m. 0 0.0%
1:00 p.m. to 1:59 p.m. 6 7.8% 11:00 p.m. to 11:59 p.m. 0 0.0%
2:00 p.m. to 2:59 p.m. 9 11.7% 12:00 a.m. to 5:59 a.m. 2 2.6%
3:00 p.m. to 3:59 p.m. 6 7.8% Missing 1 1.3%
Total 77 Accidents




Figure 2.4
Combined Frequency Distribution by Time of Day Accidents
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2.6.3  Accident Occurrence by Type of Weather

The frequency distribution for the weather conditions at the time of accident is presented in Table 2.5 and
Figure 2.5. The majority (66 percent) of accidents occurred in clear/sunny weather.

Table 2.5
Accident Frequency Distribution by Type of Weather
\Weather Frequency % Distribution
Clear/Sunny 51 66.23%
Rain 11 14.29%
Dark/Night 7 9.46%
Dusk 4 5.41%
Cloudy 3 4.05%
Fog 1 1.35%
Dawn 0 0.00%
Missing 0 0.00%
Total 77 100%




Figure 2.5
Accident Frequency Distribution by Type of Weather
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2.6.4 Accident Occurrence by Route

According to the National Transit Database, RTS operated a fleet of 83 buses in 2002. The number of bus
routes operated does fluctuate on a month by month basis, partly influenced by the academic semester.
Table 2.6 and Figure 2.6 show accident data by route.

Route 5 experienced the highest number of accidents with 7 accidents, followed by Routes 12, 13 and 75
(with 6 accidents each). These 4 routes accounted for approximately a third (25 out of 77) of all the
accidents in the study period. Table 2.6 also presents the Z-statistic for each route. A Z-statistic greater
than 1.40 can be used to identify routes that are more prone to crash occurrence relative to the other routes
in the system. This information can assist in identifying potential problem routes within the system.
Figure 2.6 shows accident frequency by route.
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Table 2.6
Accident Frequency Distribution by Route

[Route Frequency |% Distribution |Z-Statistic Route [Frequency |% Distribution |Z-Statistic
1 3 3.90% 0.140694 35 3 3.90% 0.140694
2 2 2.60% -0.42208 43 1 1.30% -0.98486
5 7 9.09% 2.391793 75 6 7.79% 1.829018
7 3 3.90% 0.140694 117 1 1.30% -0.98486
8 4 5.19% 0.703469 119 1 1.30% -0.98486
9 4 5.19% 0.703469 120 2 2.60% -0.42208
10 4 5.19% 0.703469 121 2 2.60% -0.42208
11 1 1.30% -0.98486 127 3 3.90% 0.140694
12 6 7.79% 1.829018 201 1 1.30% -0.98486
13 6 7.79% 1.829018 255 1 1.30% -0.98486
15 2 2.60% -0.42208 300 1 1.30% -0.98486
16 3 3.90% 0.140694 301 1 1.30% -0.98486
20 2 2.60% -0.42208 302 1 1.30% -0.98486
24 3 3.90% 0.140694 na 3 3.90% 0.140694

Total 77 100.00%
Figure 2.6
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2.6.5 Accident Occurrence by Type of Involvement

Table 2.7 presents the four routes with the highest level of accidents according to their accident type
percentage. From this analysis, it is apparent that for two of the Routes 12 and 5, 50 percent of accidents
were either rear end or angle. For Route 13, 85 percent of accidents that occurred were rear end. Route 5
was the only route out of those with high accident rates that had accidents in all three major categories;
rear end, sideswipe and angle.

Table 2.7
Highest Level of Accidents by Type
Route % Rear End | 9% Sideswipe % Angle % Other
5 14 14 58 14
12 50 - 50 -
13 83 - 17 -
75 50 - 50 -

2.6.6  Frequency by Type of Involvement

The frequency distribution for bus accident occurrence by type of involvement is presented in Table 2.8.
The data clearly show that the majority (84 percent) of accidents occurred with other motor vehicles,
followed by accidents with fixed objects, (e.g. tree) at 9 percent. Fortunately, accidents involving
pedestrians amounted to zero. Recognizing the university nature of Gainesville and the potentially high
level of student pedestrian activity (especially in locations such as the Hub), this is a great achievement.

Table 2.8
Frequency Distribution for Type of Involvement

Type of Involvement Frequency Percent Distribution
Motor Vehicle 65 84

Fixed Object 7 9
Pedestrian 0 0

Another RTS Bus 2 3

Parked vehicle 2 3
Miscellaneous 1 1

Total 77 100

Of the two accidents involving another RTS bus, one occurred at the RTS Administration facility. Other
studies have shown that accidents involving vehicles from the same transit company tend to occur on the
property of the transit company, (e.g. maintenance facilities, etc.). In these cases, individuals other than
regular operators, (e.g. mechanics and fuelers) may have been operating the buses.

12



2.6.7  Accident Occurrence Identified by Preventability Status

The frequency distribution for preventability status is presented in Table 2.9. Only two categories of
preventability were recorded by RTS, preventable and non-preventable. The 61 percent of accidents as
indicated in Table 2.9 were non preventable.

Table 2.9
Accident Frequency and Distribution by Identified by Preventability Status
Preventability Status Frequency Percent Distribution
Preventable 30 39
Non-Preventable 47 61
Total 77 100

2.6.8 Preventability Status and Accident Type

Table 2.10 presents the same information according to the four general accident categories. From Table
2.10 it is evident that the majority of rear end and angle type accidents were non-preventable, in these
instances the other party was at fault. In the case of sideswipe and other type of accidents, the opposite
was true. The bus operator was at fault or contributed to the accident.

Table 2 .10
Percentage of Accidents by Preventability Status by Accident Type
Preventability Status % Rear End | % Sideswipe % Angle % Other
Preventable 21 62 47 75
Non-Preventable 79 38 53 25
Total 100 100 100 100

2.6.9 Type of Accident according to Time of Day

Table 2.11 represents time periods with the highest number of accidents according to type:

= Four rear end accidents occurred during the time period 4:00 p.m. to 4:59 p.m., which was also the
period with the highest number of accidents overall..

e Two sideswipe type of accidents occurred during the time period 12:00 p.m. to 12:59 p.m.

e Six angle type of accidents occurred in time period 2:00 p.m. to 2:59 p.m. This time period also had
the highest total number of accidents (9), together with the time period 4:00 p.m. - 4:59 p.m.

e Rear end impacts accounted for 42 percent of all accidents,

e Sideswipe 11 percent,

e Angle 42 percent

e Other 5 percent.

13



Table 2.11
Time Day by Type of Accident

Rear | Sideswipe | Angle | Other | Total
Time of Day End
6:00 a.m. to 6:59a.m.
7:00 a.m. to 7:59a.m.
8:00 a.m. to 8:59a.m.
9:00a.m. to 9:59a.m
10:00 a.m. to 10:59 a.m.
11:00 a.m. to 11:59a.m.
12:00 p.m. to 12:59p.m.
1:00 p.m. to 1:59 p.m.
2:00 p.m. to 2:59 p.m.
3:00 p.m. to 3:59 p.m.

4 :00 p.m. to 4:59 p.m.
5:00 p.m. to 5:59 p.m.
6:00 p.m. to 6:59 p.m.
7:00 p.m. to 7:59 p.m.
8:00 p.m. to 8:59 p.m. - -
9:00 p.m. to 9:59 p.m. 1 1
10:00 p.m. to 10:59 p.m. - - - - -
11:00 p.m. to 11:59 p.m. - - - - -
12:00 a.m. to 5:59 a.m. 1 - 1 - 2
Unknown 1 - - -
Total 33 8 32 4 77
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2.6.10 Crash Occurrence by Years of Operator Experience

Accident data collected by RTS also indicates the date of hire of the operator involved. From this
information it is possible to calculate the years of experience of the operator at the time of the accident
and then determine if length of driving experience has some relevance to accident potential. Table 2.12
presents frequency distributions of accidents with respect to length of operator service at the time of the
accident. The first two columns show the distribution of all collision occurrences by operator experience
categories. Columns 3 and 4 present data for preventable crashes only. The final column illustrates the
distribution of RTS bus operators by level of experience based on July 2003 data.

In Table 2.12 operators with less than one year experience were responsible for 32 percent of the
accidents in the study period. This group was followed by those with 3 years (18 percent) and 1 year (14
percent). Operators with 3 years or less RTS experience accounted for more than 66 percent of the
accidents in the study period. Assessing preventable accidents only, the same categories of years of
service; <1 year were responsible for 40 percent, followed by 1 year with 23 percent and 3 years with 20
percent of accidents. Operators with 3 years or less accounted for more than 80 percent of the preventable

accidents.
14



Accident tendency of operators with 3 or less years of service was greater than that of their percentage
makeup of RTS operators. In the all accidents category, operators with < 3 years of service accounted for
69 percent of accidents compared to being 62 percent of the RTS bus operator population (as of July
2003). In the preventable accidents category, the statistics were 86 percent to 62 percent. From these
cursory observations, it is evident that RTS bus operators with 3 years or less of service, were involved in
the majority of accidents (of either non preventable or preventable) and may benefit from additional
training with respect to accident mitigation and prevention.

Table 2.12

Frequency Distribution of Crashes and Operators by Operator Experience
Years of Frequency Valid % Frequency Valid % Operator %
Experience (All) Distribution | (Preventable) | Distribution Distribution (2003)
<lyr 25 32 12 40 28.5
1 11 14 6 20 18.5
2 4 5 1 3 3.8
3 13 18 7 23 11.5
4 7 9 2 7 12.3
5 1 1 - - 6.9
6 2 2 - - 0.8
7 - 1 - - 1.5
8 1 1 1 3 0.8
9 - - - - 1.5
10 3 4 - - 3.1
11 - - - - -
12 - - - - -
13 - - - - -
14 1 1 - - 1.5
15 1 1 - - 1.5
16 or more 3 4 1 3 7.7
Missing 4 5 - - Na
Total 77 100 30 100

2.7 Accidents per Service Mile

The monthly totals of revenue service miles and the number of accidents are illustrated in Figure 2.7,
clearly shows the peak and trough nature of the data. Revenue service miles provided by RTS, peaked
during the months of October (early part of the Fall Semester) and April. The month with the lowest
revenue service miles is June, which is also the period during which the RTS bus operator’s refresher
training courses are typically held. Figure 2.8 illustrates the accident totals per 100,000 revenue miles by
month and cumulatively.
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Figure 2.7
Revenue Service Miles Provided and Number of Accidents
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2.7.1  Summary of General Occurrence Characteristics

Based on a review of the frequency distributions as contained in the preceding sections, it was determined
that a ‘typical’ accident for a RTS bus operator during the study period:

e Occurred during the months of September or October
e Occurred on a Tuesday

e Occurred between the hours of 4:00 p.m. - 5:00 p.m.
e Occurred in clear weather

e Occurred on Route 5

e Involved another motor vehicle

o Either a rear end or angle type of accident

e Was non-preventable and

e Involved an operator with less than 3 years experience

2.8  Other Factors Influencing Accident Potential

Discussions with RTS officials revealed the additional information which has impacted the accident
potential of RTS bus operators. These can be summarized as follows:

e Seasonal Variation of Service Supply and Hiring
RTS bus services are significantly reduced during the summer months, as the

school and UF student population levels are generally small (major users of RTS
services). At the start of the academic year, September and October are the busiest
months for RTS. It is during this time, that RTS puts into service new operators
which were hired during the summer months. These new operator gain their initial
bus operating experience during the months of peak demand for RTS services.

e Service Expansion and Penetration
RTS in recent months has seen continuous expansion and penetration in

Gainesville. Not only has there been an increase in route frequency but there has
been a penetration into new parts of Gainesville that were not served beforehand.
New operators, operating new routes in new areas, may be subjected initially to
unfamiliar road and driving conditions, which in turn can impact on accident
potential.

e Operator Fatigue
Many new RTS bus operators take advantage of the overtime and may work up to a

maximum of 98 hours per pay period. Operators may want to drive a 13 hour day 6
days a week, some of whom start their day at 4 a.m. in the morning. With ongoing
route expansion, opportunities for overtime are abundant, and newly hired
operators may take advantage of these opportunities.
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e Operator Hierarchy and Protocols
New operators being lower down on the bus operator seniority list may also be

more likely to operate on routes that may not be the easiest, in terms of hours
worked, route length etc. In addition, when senior operators select their routes,
often there are many routes still outstanding even after the younger operators have
been accommodated. These additional routes, then fall under overtime, which the
younger operators are encouraged into servicing.

o Development in Gainesville
Ongoing development within the City of Gainesville has resulted in a number of

construction and development sites being created. Such sites have resulted in bus
route diversions and delays, from time to time. Rescheduling and rerouting
services to overcome these obstacles may also increase the potential for accidents.

e Gainesville as a University City
Gainesville being a university city has a large resident student population.

Younger car drivers may manifest a higher level of driver aggression, and this may
impact on the number of non-preventable accidents, e.g. rear-enders, RTS bus
operators are exposed to.

2.8.1 Accident Location by Geographic Area

Geo-coding of accident data allows the identification of problem location on the RTS Network. Figure
2.9 is an example 31 accidents that have been manually geo-coded to a base map. This tool could be use
to identify patterns in accident location that could be a result of roadway configuration and signalization,
traffic congestion, and bus stop location.
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Figure 2.9

Bus Accident Locations - Gainesville
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CHAPTER 3 SARASOTA COUNTY TRANSPORTATION AUTHORITY

On April 9, 1979, Sarasota County entered the public transit business by taking over a county operated
bus system from Cities Transit, a private transit operator. This acquisition led to the formation of the
Sarasota County Transportation Authority, informally known at Sarasota County Area Transit (SCAT).
SCAT is an organizational member of the Sarasota County Government and is also governed by a five-
member Board of County Commissioners. SCAT serves the urbanized portion of Sarasota County
(including the cities of Longboat Key, Sarasota, Venice, Englewood and North Port) via fixed-route and
demand-response service. Since the County entered the public transit arena, bus patronage levels have
dramatically increased from approximately 700,000 riders in the early 1980°s to more than 1.8 million in
the late 1990’s. In SCAT’s 20 years of service, more than 20 million passengers have taken advantage of
SCAT’s transit services.

According to the 2002 National Transit Database (NTD), SCAT service area encompasses approximately
159 square miles, with a service area population of 308,000. Fixed route service is provided 7 days a
week with a fleet of 41 buses with reduced service on the weekends. In 2002, over 1.5 million unlinked
trips were made on SCAT services. This was a 7 percent decrease the 2001 ridership figure (see Figure
3.1).

Figure 3.1
SCAT Bus Ridership Trends (Directly Operated)
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3.1 SCAT Safety Programs

During September 2001 to August 2003 limited remedial safety training was given to every bus operator
at SCAT, this is in addition to the mandated induction course given at the commencement of hiring.
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3.2 Accident Database

SCAT records all accidents which involve buses even when a third party may have been involved. Data
collected is placed in MS Excel format. Through such data collection, basic accident statistics are
captured on a regular basis, which are subsequently used as management information. Basic analysis of
the data by the SCAT Review Board tries to ascertain common safety problems and accident locations.
This analysis leads to recommendations being made to management, to effect changes in order to remedy
the problems identified. Detailed statistical analysis of the data is not regularly performed partly due to
the low number of accidents.

3.3 Accident Analysis

Accident data records used in this study were obtained from SCAT offices in Sarasota. SCAT staff
collected and prepared the records, while CUTR staff captured the data in MS Excel format. Questions
requiring clarification of records input were answered by SCAT staff either on site or by telephone.

3.4  Analysis Period

The total accident analysis time frame was from September 2001 to August 2003 (24 months).
Management determines when Remedial Safety Refresher Training Programs are held.

3.5 General Occurrence Characteristics

A total of 95 accidents occurred during the 24 month period of September 2001 through August 2003.
Accident data is presented in Table 3.1 and Figure 3.2. Column 2 of Table 3.1 presents the number of
accidents per month. The percentage distribution of these accidents is determined by the monthly
accidents divided by the total number of accidents in the study period. Average frequency (per year) is
derived by the number of accidents divided by the number of years for which those accidents were
submitted.

22



Number of Accidents

Table 3.1

Combined Frequency Distribution of Monthly Accidents

Average
Month Number % Distribution Frequency Years of Data
January 10 11 5 2
February 10 11 5 2
March 11 12 55 2
April 7 7.4 3.5 2
May 4 42 2
June 6 6.3 2
July 4 42 2
August 9 9.5 4.5 2
September 6 6.3 3 2
October 13 14 6.5 2
November 9 9.5 4.5 2
December 6 6.3 3 2
Total 95 100.0
Figure 3.2
Combined Frequency Distribution of Monthly Accidents
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The highest number of accidents (13) occurred in the month of October with the average frequency also
being the highest (6.5) followed by March, January and February. The months with the lowest average
frequency of accidents were May and July followed by June, September and December. These months all
experienced lighter traffic levels than the peak visitor seasons.

3.5.1 Crash Occurrence by Day of Week

Crash occurrence data by day of week is presented in Table 3.2 and in Figure 3.3. Table 3.2 also presents
accident data frequency by day of week. Overall, Mondays and Thursdays were the days with the highest
numbers of accidents with 19 each. The lack of Sunday bus operation coupled with lower levels of
traffic, accounted for the one bus accident (over the entire study period) which occurred on this day.

Table 3.2
Combined Frequency Distribution of Day of Week Accidents
Month Frequency % Distribution |Average Frequency Days
Sunday 1 1.05 0.010 105
Monday 19 20.00 0.181 105
Tuesday 14 14.74 0.135 104
Wednesday 16 16.84 0.154 104
Thursday 19 20.00 0.184 103
Friday 13 13.68 0.125 104
Saturday 13 13.68 0.124 105
Total 95 100.0 0.130 730
Figure 3.3

Combined Frequency Distribution of Day of Week
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3.5.2  Accident Occurrence by Time of Day

Table 3.3 and Figure 3.4 present data on accident occurrence by time of day. The time period with the
highest number of accidents is between 2:00 p.m. - 2:59 p.m. The second busiest period for accident
occurs between 4:00 p.m. - 4:59 p.m. during the evening peak. SCAT does not operate evening service
from 8:00 pm to midnight as a result the table shows 0 accidents for that time period. Table 3.3 presents
data on accident type by time period.

Table 3.3
Combined Frequency Distribution by Time of Day Accidents
Time of Day Frequency| % Distribution |Time of Day Frequency| % Distribution
6:00 a.m. to 6:59a.m. 5 5.3% 4:00 p.m. to 4:59 p.m. 9 9.5%
7:00 a.m. to 7:59a.m. 4 4.2% 5:00 p.m. to 5:59 p.m. 2 2.1%
8:00 a.m. to 8:59a.m. 7 7.4% 6:00 p.m. to 6:59 p.m. 3 3.2%
9:00a.m. to 9:59a.m 3 3.2% 7:00 p.m. to 7:59 p.m. 4 4.2%
10:00 a.m. to 10:59 a.m. 6 6.3% 8:00 p.m. to 8:59 p.m. 0 0.0%
11:00 a.m. to 11:59a.m. 6 6.3% 9:00 p.m. to 9:59 p.m. 0 0.0%
12:00 p.m. to 12:59p.m. 6 6.3% 10:00 p.m. to 10:59 p.m. 0 0.0%
1:00 p.m. to 1:59 p.m. 5 5.3% 11:00 p.m. to 11:59 p.m. 0 0.0%
2:00 p.m. to 2:59 p.m. 11 11.6% 12:00 a.m. to 5:59 a.m. 2 2.1%
3:00 p.m. to 3:59 p.m. 8 8.4% Missing 16 14.7%
Total 95 Accidents
Figure 3.4
Combined Frequency Distribution by Time of Day Accidents
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3.5.3 Accident Occurrence by Route

During the SCAT FY2002, SCAT operated a variety of routes with a fleet of 50 buses (NTD data). Over
the study period the number of routes operated did not fluctuate on a month by month basis (SCAT
generally operates the same schedule year round). Table 3.4 and Figure3.5 present accident data by route.

Table 3.4
Accident Frequency Distribution by Route

Route|Frequency|% Distribution] Z-Statistic Route [Frequency|% Distribution|Z-Statistic
1 4 4.2% -0.029690 13 0 0.0% -0.940184
2 3 3.2% -0.257313 14 3 3.2% -0.257313
3 2 2.1% -0.484937 15 7 7.4% 0.653180
4 2 2.1% -0.484937 16 2 2.1% -0.484937
5 6 6.3% 0.425557 17 15 15.8% 2474167
6 6 6.3% 0.425557 18 0 0.0% -0.940184
7 3 3.2% -0.257313 19 3 3.2% -0.257313
8 6 6.3% 0.425557 Garage 1 1.1% -0.712560
9 2 2.1% -0.484937 Charter 2 2.1% -0.484937
10 0 0.0% -0.940184 Trolley 5 5.3% 0.197933
11 2 2.1% -0.484937 Missing 18 18.9% 3.157038
12 3 3.2% -0.257313 Total 95 100%

The Route 17 experienced the highest number of accidents (15) accidents followed by Route 5 with 7
accidents. Route 17 accounted for 15 percent of all the accidents in the study period with a Z-Statistic of
2.47. A Z-statistic over 1.40 can be used to identify routes that are more prone to crash occurrence
relative to the other routes in the system. Route 17 is the only route which surpasses this threshold.

Figure 3.5
Accident Frequency Distribution by Route
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3.5.4  Accident Occurrence by Type of Involvement

The frequency distribution for bus accident occurrence by type of involvement is presented in Table 3.5.
The data clearly indicates that of the 6 categories of accident types, the majority involved a motor vehicle

(81 percent), followed by collisions with fixed objects (19 percent).

Table 3.5

Frequency Distribution for Type of Involvement

Type of Involvement Frequency Percent Distribution
Motor Vehicle 77 81

Fixed Object 18 19
Pedestrian 0 0

Another SCAT Bus 0 0

Parked vehicle 0 0
Miscellaneous 0 0

Total 95 100

Very few accidents occurred on SCAT property. Other studies have shown that accidents involving
vehicles from the same transit company tend to occur on the property of the transit company. In these
cases, individuals other than regular operators, e.g. mechanics and feelers operate the buses.

3.5.5 Type of Accident according to Time of Day
A review of the time periods with the highest number of accidents according to type (Table 3.6) reveals
that:
e Rear end accidents (5) occurred during the time period 10:00 a.m. to 10:59 a.m.
e Sideswipe accidents (2) occurred during the time periods 2:00 p.m. to 2:59 p.m. and 3:00 p.m. to
3:59 p.m.
e Angle accidents (5) occurred during the time period 3:00p.m to 3:59p.m.
e 3 other types of accidents (e.g. hitting a fixed object) occurred during the time period 2:00 p.m. to
2:59p.m.

Overall, rear end accidents accounted for 31 percent of all accidents, sideswipe accounted for 15 percent;
angle in 38 percent of accidents and other types comprised of 16 percent.
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Table 3.6

Time Day by Type of Accident
Time of Day Rear End | Sideswipe Angle Other Total
6:00 a.m. to 6:59a.m. 2 1 2 -
7:00 a.m. to 7:59a.m.
8:00 a.m. to 8:59a.m.
9:00a.m. to 9:59a.m
10:00 a.m. to 10:59 a.m.
11:00 a.m. to 11:59a.m. -
12:00 p.m. to 12:59p.m.
1:00 p.m. to 1:59 p.m.
2:00 p.m. to 2:59 p.m.
3:00 p.m. to 3:59 p.m. -
4:00 p.m. to 4:59 p.m.
5:00 p.m. to 5:59 p.m.
6:00 p.m. to 6:59 p.m. - 1
7:00 p.m. to 7:59 p.m. - 1
8:00 p.m. to 8:59 p.m. - - - -
9:00 p.m. to 9:59 p.m. - - - -
10:00 p.m. to 10:59 p.m. - - - -
11:00 p.m. to 11:59 p.m. - - - -
12:00 a.m. to 5:59 a.m. - - 1
[Unknown 5 2 5 2
Total 30 14 36 15
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3.5.6  Type of Accident according to Bus Route

Table 3.7 presents SCAT bus routes and accident type (ranked according to frequency). On Route 17, the
majority of accidents were rear end. On Route 15 rear end accidents accounted for more than 50 percent
of all accidents. Routes with the highest accident frequency are 17, 15, 5, 6 and 8. Route 17 was the only
route involved in all four accident type categories (e.g. rear end, sideswipe, angle and other). The four
other routes were involved in a maximum of three of the four accident type categories. These 5 routes
combined were involved in total of 40 accidents, of which 75 percent were rear end and angle type of
accidents.
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Table 3.7
Accident Occurrence by Route and Type (Ranked)

Route Rear End Sideswipe Angle Other Total
17 7 1 2
15 4 1 1
5 1 1

6 4
8
Trolley
1 1
2 1
7
12
14
19
3 2
4
9 1
11 1
16 1
Charter
Garage
10
13
18
Missing 6 2 6 4
TOTAL 30 14 36 15
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3.5.7  Accident Occurrence by Type of Weather and Road Condition

The frequency distribution of prevailing weather and road conditions at the time of the accident is
presented in Table 3.8 and Figure 3.6 The majority of accidents (62 percent) occurred in clear weather.
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Number of Accident Occuring

Table 3.8
Accident Occurrence by Type of Weather and Road Condition

\Weather Road Condition Frequency % Distribution
Clear Dry 62 65.3%
Wet - -
Rain Dry - -
Wet 5 5.3%
Dark/Night Dry 1 1.1%
Wet - -
Dusk/Semi Dark Dry 1 1.1%
Wet - -
Cloudy Dry 5 5.3%
Wet 2 2.1%
Fog Dry - -
Wet 2 2.1%
Dark & Clear Dry 1 1.1%
Wet - 0.0%
Missing na 16 16.8%
Total 95
Figure 3.6

Accident Frequency Distribution by Type of Weather
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3.5.8  Accident Occurrence Identified By Preventability Status

SCAT did not record an indication of the preventable versus non-preventable on their accident records.

3.5.9 Crash Occurrence by Years of Operator Experience

Accident data collected by SCAT indicates the date of hire of the bus operator involved. From this
information it is possible to calculate the of years of driving experience the operator had at the time of the
accident and if there is any relationship between length of driving operation and accident potential. Table
3.9 presents frequency distributions of accidents with respect to length of service at the time of accident.
The first two columns present the distribution of all collision occurrences by the operator experience
categories. The final column illustrates the distribution of SCAT operator by level of experience based on
August 2003 data.
Table 3.9
Frequency Distribution of Accidents
According to Years of Operator Experience

Years of Experience at SCAT Frequency (All) Valid % Distribution

<lyr 17 18

1 13 14

2 7 7

3 12 13

4 4 4

5 3 3

6 3 3

7 3 3

8 0 0

9 2 2

10 1 1

11 2 2

12 1 1

13 3 3

14 1 1

15 or more 4 4
Missing 19 20
Total 95 100

Operators with less than one years experience were responsible for 18 percent of the accidents in the
study period. This group was followed by those with 1 year (14 percent) and 3 years (13 percent).
Operators with 3 years or less of bus operations for SCAT accounted for just over half (52 percent) of all
accidents in the study period.
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3.6 Accidents per Service Mile

The monthly totals of revenue service miles supplied by SCAT and the corresponding number of bus
accidents are illustrated in Figure 3.7. This graphic clearly shows the peak and trough nature of bus
accidents per 100,000 revenue service miles. Data on revenue service miles supplied was provided by
SCAT for the FY 2003. Monthly totals in the FY 2001 and FY 2002 were estimated using the yearly
totals from the National Transit Database (1.5 million and 1.6 million miles) and by proportioning these
figures according to the monthly amounts of the 2003 data. Figure 3.8 illustrates the accident totals per
100,000 revenue miles by month.

Figure 3.7
Revenue Miles per Month Supplied versus Number of Accidents
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# Accidents

3.7

Figure 3.8
Accidents per 100,000 Revenue Miles by Month
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Summary of General Occurrence Characteristics

Based on a review of the frequency distributions as contained in the preceding sections, a ‘typical’

accident for a SCAT bus operator during the study period:

3.8

Occurred during the month October

Occurred on a Monday or Thursday

Occurred between 2:00 p.m. to 3:00 p.m.

Occurred in clear weather

Occurred on Route 17

Involved another motor vehicle

Was an angle type of accident and

Involved an operator with less than 3 years experience

Other Factors Influencing Accident Potential

Discussions with SCAT officials revealed the following additional information which has impacted the

accident potential of SCAT bus operators.
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=  New Bus Operators
New bus operators having to operate under a new operating routine when compared to
their previous employer may increase accident potential in the initial transitional phase.
New operators, operating new routes in new areas, may be subjected initially to
unfamiliar roads and driving conditions, which in turn can impact on accident potential.

= Operator Fatigue
Many new SCAT bus operators take advantage of overtime and may work up to a
maximum of 98 hours per pay period. Operators may drive a 13 hour day, 6 days a week,
some of whom start their day very early in the morning. Route expansion or changes, as
well as driver absenteeism, provide opportunities for overtime, which newly hired
operators may take a greater propensity to advantage of these opportunities.

3.8.1 Accident Location by Geographic Area

Geo-coding of accident allows the identification of problem location on the SCAT Route Network.
Figure 3.90 is an example of 25 accidents that have been manually geo-coded to a base map. This tool
could be used to identify patterns in accident location that could be a result of roadway configuration and
signalization, traffic congestion, and bus stop location.
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Bus Accident Locations- Sarasota County
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CHAPTER 4 VOLUSIA COUNTY PUBLIC TRANSIT SYSTEM

According to the Census 2003 population estimate, more than 465, 000 people call Volusia County home.
Volusia County is situated on the east coast of Central Florida and has 47 miles of Atlantic Ocean
coastline. Volusia County includes the cities of Daytona Beach (famous for motor racing), Ormond Beach
and New Smyrna Beach. The 2003 population estimate ranked Volusia County as the 11™ most populous
county in Florida.

County of Volusia, dba: VOTRAN is a county-wide tax-supported public transit system. According to the
2002 National Transit Database, VOTRAN had a fleet of 60 revenue-producing fixed route buses
operating over a route network of 645 miles, with additional vehicles leased or contracted to satisfy
transportation demand. In 1993, VOTRAN received the American Public Transit Association's (APTA)
award for the “Outstanding Transit System in North America.” During the first six months of 1995,
VOTRAN was ranked seventh in growth among all U.S. public transit systems by APTA. VOTRAN
received the Florida Department of Transportation's top safety award in 1992-94, 1996-97, 2000, and
placed second in 1998 and 1999. In 2002, VOTRAN provided 2,963,000 unlinked passenger trips, a 22
percent decrease from 2001 ridership level (3,817,000) as shown in Figure 4 1.

Figure 4.1
VOTRAN Ridership Trends
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4.1 VOTRAN Safety Training

The VOTRAN Safety Manager is tasked with training operators in safety techniques of bus driving and
operations. The Safety Manager is certified by the Transportation Safety Institute and is assisted by other
safety staff (certified defensive driving instructors) when training is needed. All new operators joining
VOTRAN are required to complete the Commercial Drivers License (CDL) course.
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4.2 VOTRAN Safety Programs

According to information received from VOTRAN, a safety training course is conducted at least once
every two years (preferably on an annual basis). All bus operators are required to participate in this
course. The course is conducted during the month of October which is typically a ‘down’ month with
respect to VOTRAN bus operations. October Fest and Daytona Motor Racing which impact public transit
demands in the county are over.

The safety training course is typically a two to four hour class offering training on defensive driving
techniques. The chief instructor is assisted by up to five supervisors (when necessary). Trained personnel
within VOTRAN permit the course to be given in-house rather that using contracted professional training
service providers. Safety classes range in size from 12 - 45 students, but class size is usually kept to 30 or
less students. Currently, VOTRAN has approximately 170 bus operators to put through the program.

In order to make the syllabus directly relevant to VOTRAN’s bus operator’s needs, the safety training
manager does a preliminary assessment of all bus accidents occurring in the intervening period from the
last training course. This enables identification of any accident trends, e.g. rear end or sideswipe, which
allows the safety training program manager to concentrate on these types of accidents and minimize the
potential of bus operators being involved in these types of accidents in the future. Accident trends that
cause concern to the safety training manager are targeted objectives of the training program to correct the
problem.

VOTRAN has in place a rolling-program of safety training. It is the requirement of every bus operator
that has been involved in an accident to retake the defensive driving course that was initially given at the
start of their hire at VOTRAN. Overall, the bus safety programs have paid dividends, as VOTRAN is
highly ranked in Florida State rankings for the lowest number of bus accidents (taking into account
property and fleet size).

4.3 Accident Database

All accidents involving any VOTRAN bus is recorded by VOTRAN, even when a third party may have
been involved. Through such data collection, basic accident statistics are captured on a regular basis,
which are subsequently used as management information. In-depth statistical analysis of the data is not
performed (partly due to the low number of accidents).

4.4  Accident Analysis and Period of Analysis

Accident data used in this study was captured at the VOTRAN offices in South Daytona. VOTRAN staff
collected and prepared the records while CUTR staff captured the data in MS Excel format. Any
questions seeking clarification of records input were answered by VOTRAN staff either on site or by
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telephone. This analysis was done entirely in MS Excel, due to the small number of accident record. The
total analysis time frame was from July 2001 to June 2003 (24 months).

4.5 General Occurrence Characteristics

A total of 124 accidents occurred during the 24 month period from July 2001 through June 2003 as shown
in Table 4.1 and Figure 4.2. Column 2 of Table 4.1 presents the number of accidents per month. The
percentage distribution of these accidents is determined by the monthly accidents divided by the total
number of accidents in the study period. Average frequency (per year) is derived by the number of
accidents divided by the number of years for which those accidents were submitted.

Table 4.1
Combined Frequency Distribution of Monthly Accidents
Average
Month Number % Distribution Frequency Years of Data
January 7 5.6% 3.5 2
February 8 6.5% 4.0 2
March 20 16.1% 10.0 2
April 9 7.3% 4.5 2
May 6.5% 4.0 2
June 15 12.1% 7.5 2
July 10 8.1% 5.0 2
August 7 5.6% 3.5 2
September 5 4.0% 2.5 2
October 9 7.3% 4.5 2
November 15 12.1% 7.5 2
December 11 8.9% 5.5 2
Total 124 100.0%

The month of March experienced the highest number of accidents (based on average frequency), followed
by June and November.
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Figure 4.2
Combined Frequency Distribution of Monthly Accidents
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4.5.1 Crash Occurrence by Day of Week

Crash occurrence data by day of week is presented in Table 4.2 and in Figure 4.3. Table 4.2 also presents
data as to the accident frequency by day of week. Overall, Wednesday and Friday were the days with the
highest numbers of accidents (24 each). The reduced Sunday bus operation may account for the
significantly lower numbers of accidents occurring on this day.

Table 4.2
Combined Frequency Distribution of Day of Week Accidents

Month Frequency % Distribution |Average Frequenc # Years
Sunday 6 4.8% 3.0 2.0
Monday 22 17.7% 7.3 3.0
Tuesday 14 11.3% 7.0 2.0
Wednesday 24 19.4% 12.0 2.0
Thursday 14 11.3% 7.0 2.0
Friday 24 19.4% 12.0 2.0
Saturday 20 16.1% 10.0 2.0
Total 124 100.0% 413 3.0
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Figure 4.3
Combined Frequency Distribution of Day of Week Accidents
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Table 4.3 and Figure 4.4, presents the accident occurrence by time of day. The time periods with the
highest number of accidents are during lunch hour and the late afternoon time periods from 11:00 a.m. -
5:00 p.m. This five hour period accounted for 74 accidents or 59 percent of the total number of crashes.
The hour between 1:00 p.m. - 1:59 p.m. experienced the highest accident frequency overall with 14

Table 4.3
Combined Frequency Distribution by Time of Day Accidents
Time of Day Frequency, % Time of Day Frequency %
Distribution Distribution
6:00 a.m. to 6:59a.m. 2 1.61% 4 :00 p.m. to 4:59 p.m. 10 8.06%
7:00 a.m. to 7:59a.m. 9 7.26% 5:00 p.m. to 5:59 p.m. 6 4.84%
8:00 a.m. to 8:59a.m. 5 4.03% 6:00 p.m. to 6:59 p.m. 4 3.23%
9:00a.m. to 9:59a.m 6 4.84% 7:00 p.m. to 7:59 p.m. 4 3.23%
10:00 a.m. to 10:59 a.m. 8 6.45% 8:00 p.m. to 8:59 p.m. 0 0.00%
11:00 a.m. to 11:59a.m. 12 9.68% 9:00 p.m. to 9:59 p.m. 0 0.00%
12:00 p.m. to 12:59p.m. 13 10.48% 10:00 p.m. to 10:59 p.m. 2 1.61%
1:00 p.m. to 1:59 p.m. 14 11.29% 11:00 p.m. to 11:59 p.m. 1 0.81%
2:00 p.m. to 2:59 p.m. 13 10.48% 12:00 a.m. to 5:59 a.m. 2 1.61%
3:00 p.m. to 3:59 p.m. 12 9.68% Missing 1 0.81%
Total 124 Accidents

41



Figure 4.4
Combined Frequency Distribution by Time of Day Accidents
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4.5.3 Accident Occurrence by Type of Weather

The frequency distribution for the weather conditions at the time of accident is presented in Table 4.4 and
Figure 4.5. The majority (73 percent) of accidents occurred in clear weather.

Table 4.4
Accident Frequency Distribution by Type of Weather
\Weather Frequency % Distribution
Clear 90 72.58%
Rain 20 16.13%
Overcast 14 11.29%
Total 124 1
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Figure 4.5

Accident Frequency Distribution by Type of Weather
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45.4  Accident Occurrence by Road Condition

90%

80%

70%

60%

50%

40%

30%

20%

10%

- 0%

Overcast

100%

Percent Distribution

The frequency distribution for the road conditions at the time of accident is presented in Table 4.6 and

Figure 4.6. The majority (83 percent) of accidents occurred on dry road conditions.

Table 4.5
Accident Frequency Distribution by Road Condition
Roadway Condition Frequency % Distribution
Dry 104 83.87%
'Wet/Slippery 0 16.13%
Total 124 100.0%
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Figure 4.6
Accident Frequency Distribution by Road Condition
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45.5 Accident Occurrence by Route

During the SCAT Fiscal Year ending 2002, VOTRAN operated a variety of routes with a fleet of 58
buses (NTD data). The number of routes operated does fluctuate on a month by month basis. Table 4.7
presents accident data by route.

Table 4.6
Accident Frequency Distribution by Route
[Route Frequency | % Distribution | Z-Statistic Route Frequency | % Distribution | Z-Statistic

1A 6 4.8% 0.4429 17A 2 1.6% -0.8159
1B 11 8.9% 2.0165 17B 3 2.4% -0.5012
3 9 7.3% 1.3870 20 6 4.8% 0.4429
4 11 8.9% 2.0165 22 2 1.6% -0.8159
5 7 5.6% 0.7576 40 2 1.6% -0.8159
6 8 6.5% 1.0723 41 1 0.8% -1.1306
7 4 3.2% -0.1865 42 1 0.8% -1.1306
8 3 2.4% -0.5012 43 1 0.8% -1.1306
9 3 2.4% -0.5012 60 4 3.2% -0.1865
10 6 4.8% 0.4429 Tram/Trolley 4 3.2% -0.1865
11 4 3.2% -0.1865 ||Garage/Maint 2 1.6% -0.8159
12 7 5.6% 0.7576 Other 10 8.1% 1.7018
15 5 4.0% 0.1282 Missing 0 0.0% -1.4453
17 2 1.6% -0.8159 Total 124
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The routes which experienced the highest number of accidents were Route 1B and Route 4 (11 accidents
each), followed by Route 3 with 9 accidents. These 3 routes accounted for a quarter of all the accidents in
the study period. Table 4.7 also presents the Z-statistic for each route. A Z-statistic greater than 1.40 can
be used to identify routes that are more prone to crash occurrence relative to the other routes in the
system. This information can assist in identifying potential problem routes within the system. Figure 4.7
presents accident frequency by route.
Figure 4.7
Accident Frequency Distribution by Route
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4.5.6  Accident Occurrence by Type of Involvement

The frequency distribution for accident occurrence by type of involvement is presented in Table 4.7. The
data clearly show that the majority (68 percent) of accidents occurred with other motor vehicles. This
was followed by accidents with fixed objects, (e.g. tree) at 25 percent. Accidents involving parked, other
VOTRAN buses, and miscellaneous objects represented 6.5 percent of the total.

Table 4.7
Accident Occurrence by Type of Involvement

Type of Involvement Frequency Percent Distribution
Motor Vehicle 85 68.5%

Fixed Object 31 25.0%
Pedestrian 0 0.0%
Another VOTRAN Bus 3 2.4%

Parked vehicle 4 3.2%
Miscellaneous 1 0.8%

Total 124 100.0%
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Of the three accidents involving another VOTRAN bus, all three involved a parked bus. Other studies
have shown that accidents involving vehicles from the same transit agency tend to occur on the property
of the transit agency (e.g. maintenance facilities, etc.). In these cases, individuals other than regular
operators operate the buses. The movement of buses within the confined spaces of maintenance facilities
and by individuals other than the regular operators may increase the accident potential of buses according
to this scenario.

Table 4.8
Time Day by Type of Accident
Time of Day Rear End | Sideswipe Angle Other Total
6:00 a.m. to 6:59a.m. 0 1 0 1 2
7:00 a.m. to 7:59a.m. 3 1 5 0 9
8:00 a.m. to 8:59a.m. 1 3 0 1 5
9:00a.m. to 9:59a.m 3 2 0 1 6
10:00 a.m. to 10:59 a.m. 1 4 3 0 8
11:00 a.m. to 11:59a.m. 2 5 5 0 12
12:00 p.m. to 12:59p.m. 2 5 5 1 13
1:00 p.m. to 1:59 p.m. 1 9 4 0 14
2:00 p.m. to 2:59 p.m. 1 6 3 3 13
3:00 p.m. to 3:59 p.m. 4 3 3 2 12
4 :00 p.m. to 4:59 p.m. 2 6 2 0 10
5:00 p.m. to 5:59 p.m. 1 2 3 0 6
6:00 p.m. to 6:59 p.m. 1 0 1 2 4
7:00 p.m. to 7:59 p.m. 1 0 1 2 4
8:00 p.m. to 8:59 p.m. 0 0 0 0 0
9:00 p.m. to 9:59 p.m. 0 0 0 0 0
10:00 p.m. to 10:59 p.m. 1 1 0 0 2
11:00 p.m. to 11:59 p.m. 0 0 0 1 1
12:00 a.m. to 5:59 a.m. 0 2 0 0 2
|Unknown 0 0 0 1 1
Total 24 50 35 15 124

A review of the time periods with the highest number of accidents, as presented in table 4.8, reveals that:
e 9 sideswipe accidents occurred during the time period 1:00 p.m. to 1:59 p.m. which represented
64% of all accidents occurring during this time period.
e 4 rear end type accidents occurred in the time period between 3:00 p.m. and 3:59 p.m. This type
of accident represented one third of accidents in this time period.
e 5 angle type accidents occurred during the time period between 7:00 a.m. to 7:59 a.m. These 5
accidents represented 56 percent of all accidents in this time period.
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4.5.7 Accident Occurrence by Impact Dynamics

Table 4.9 presents the three routes with the highest level of accidents according to accident type
percentage. The data in the Table 4.9 indicates that Routes 1B, 3 and 4 had more than 50 percent of
accidents of the sideswipe type, with Route 4 representing three quarters of bus accidents of this type.
Angle type accidents represented the second highest percentage of accident type on Route 1B (27 percent)
and Route 3 (34 percent). Route 4 had the highest percentage of rear end accidents. Routes 1B and 4
experienced all three accident types according to categories in Table 4.9.

Table 4.9
Accident Occurrence by Impact Dynamics
[Route % Rear End % Sideswipe % Angle % Other
1B 9 55 27 9
3 - 66 34 -
4 18 73 9

4.5.8 Accident Occurrence Identified by Preventability Status

The frequency distribution for preventability status is presented in Table 4.10.Two categories were
recorded by VOTRAN: preventable and non-preventable. The majority (60 percent) of accidents were
non preventable.
Table 4.10
Accident Occurrence Identified by Preventability Status

Preventability Status Frequency Percent Distribution
Preventable 50 40
Non Preventable 74 60
Total 124 100

Table 4.11 presents the same information by the four general accident categories. From Table 4.11 it is
evident that for three accident types: sideswipe, angle and other, the accidents were preventable. In the
case of rear end accidents, the majority of these were non preventable.

Table 4.11
Accident Occurrence Identified by Preventability Status and Accident Type
Preventability Status % Rear End % Sideswipe % Angle % Other
Preventable 18 66 57 60
[Non Preventable 82 34 43 40
Total 100 100 100 100




4.5.9 Crash Occurrence by Years of Operator Experience

Accident data collected by VOTRAN also indicates the date of hire of the operator involved. From this
information it is possible to calculate the years of experience the operator had at the time of the accident
and then determine if length of driving operation has some bearing on accident potential. Table 4.12
presents frequency distributions of accidents with respect to length of service at the time of accident. The
first two columns present the distribution of all collision occurrences by the operator experience
categories. Columns 3 and 4 present data for preventable crashes only. The final column illustrates the
distribution of VOTRAN operator by level of experience based on June 2003 data.

From Table 4.12, operators with less than one year of experience were responsible for 31 percent of the
accidents in the study period, followed by operators with 6 to 7 years of experience (8 percent each).
Operators with 3 years or less VOTRAN experience accounted for more than 40 percent of the accidents
in the study period. Assessing preventable accidents only those with less than 1 year experience
accounted for 42 percent of the accidents followed ,by operators with 1, 6 and 15 years (10 percent each).
In this case, operators with 3 years or less accounted for 60 percent of the preventable accidents.

Table 4.12
Crash Occurrence by Years of Operator Experience

Years of Experience | Frequency (All) Valid % Frequency Valid %
at VOTRAN Distribution (Preventable) Distribution
<lyr 38 30.6% 21 42.0%
1 6 4.8% 5 10.0%
2 6 4.83% 4 8.0%
3 3 2.4% 0 0.0%
4 4 3.2% 0 0.0%
5 5 4.0% 1 2.0%
6 10 8.1% 2 4.0%
7 10 8.1% 5 10.0%
8 6 4.8% 1 2.0%
9 2 1.6% 1 2.0%
10 3 2.4% 0 0.0%
11 3 2.4% 1 2.0%
12 4 3.2% 0 0.0%
13 2 1.6% 0 0.0%
14 4 3.2% 1 2.0%
15 6 4.8% 5 10.0%
16 or more 12 9.7% 3 6.0%
Missing 0 0.0% 0 0.0%
Total 124 100.0% 50 100.0%
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4.6 Summary of General Occurrence Characteristics

Based on a review of the frequency distributions as contained in the preceding sections, it was determined
that a ‘typical’ accident for a VOTRAN bus operator during the study period:

e  Occurred during the month March

e Occurred on Wednesday or Friday

e  Occurred between 1:00 p.m. - 2 p.m.

e Occurred in clear weather

e Occurred along Route 1B or Route 4

e Involved another motor vehicle

e Was a sideswipe type of accident

e Was non preventable and

e Involved an operator with less than 1 year of experience

4.7  Other Factors Influencing Accident Potential

Discussions with VOTRAN officials revealed a number of factors which have impacted on the accident
potential of VOTRAN bus operators. Factors such as new bus operators and operator fatigue have
impacted negatively in ways similar to the other transit properties studied (see RTS section 2.8).
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CHAPTERS5 LEE COUNTY REGIONAL TRANSIT SYSTEM

Lee County is located in southwest Florida and is bordered by Charlotte County to the North, Hendry
County to the East, Collier County to the South, and the Gulf of Mexico to the West. The county is
approximately 805 square miles of land area. According to the U.S. Census population estimates for
2003, Lee County has an estimated population of 492,210 (the 10™ most populous county in Florida).
The largest city in Lee County is Cape Coral, which in 2003 had an estimated population of 120,439.
Fort Myers, being the second-largest city and the County Seat has an estimated 2003 population of
52,527.

Lee County Transit, known locally (and referred to in this report) as "LeeTran" is operated under the
authority of the Lee County Government and the Lee County Board of Commissioners. LeeTran
primarily operates a fixed-route, fixed-schedule type bus service. According to 2002 National Transit
Database, LeeTran operated 20 regular fixed bus routes covering over 427 miles in Lee County and
carried over 2.35 million passengers.

LeeTran provides a "Park and Ride" service to and from area beaches via a connecting replica trolley
service. LeeTran also sponsors an ADA Paratransit service for disabled citizens who are not able to
utilize the fixed route system. The paratransit service is contracted to a private provider who coordinates
trips with operators specializing in transportation services for the disabled. Public transit services are
available Monday through Saturday, from 5:00 a.m. to 9:45 p.m., with limited corridor service to the
beach areas on Sundays operating from 6:00 a.m. until 9:45 p.m., as well as service to Southwest
International Airport (SWI). LeeTran transit ridership levels are shown in Figure 5.1.

5.1 LeeTran Safety Programs

All operators joining LeeTran must complete an initial training program, which provides operators with a
basic understanding of safety and security procedures of bus operation. With respect to other safety
programs (apart from the induction course at their hiring) safety retraining is conducted with all operators
during the summer months every year.

5.2  Accident Database

LeeTran records all accidents which involve their buses, even when a third party may have been involved.
All accident and incident reports are scanned into LeeTran’s computer system after the report is
completed. Other divisions in Lee County perform accident data analysis which includes bus accidents.
Currently, LeeTran does not perform in-house data analysis in relation to accidents involving its buses.
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Ridership (Millions)

Figure 5.1
Lee County LeeTran Ridership Trends
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5.3 Accident Analysis

Accident data used in this study was submitted by LeeTran. LeeTran staff collected and prepared
the records, while CUTR staff captured the data in MS Excel format. Any questions seeking
clarification of records input were answered by LeeTran staff. Due to the small number of
accident records, the analysis was conducted entirely in MS Excel.

5.4  Analysis Period

The analysis reported here covers a period of 24 months from October 2001 to September 2003.
It should be noted that the fiscal year for LeeTran starts in October and ends in September the
following year.

5.5 General Occurrence Characteristics

A total of 99 accidents occurred during the 24 month period of October 2001 through to
September 2003, in Table 5.1 and Figure 5.2. Column 2 of Table 5.1 presents the number of
accidents per month. The percentage distribution of these accidents is determined by the monthly
accidents divided by the total number of accidents in the study period. Average frequency (per
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Nirber of Accidents

year) is derived by the number of accidents divided by the number of years for which those

accidents were submitted.

Table 5.1
Combined Frequency Distribution of Monthly Accidents
Month Number % Distribution |Average Frequency| Years of Data
January 13 13.1% 6.5 2
February 16 16.2% 8 2
March 6 6.1% 3 2
April 8 8.1% 4 2
May 8 8.1% 4 2
June 8 8.1% 4 2
July 7 71% 35 2
August 7 7.1% 3.5 2
September 11 11.1% 5.5 2
October 7 7.1% 3.5 2
November 4 4.0% 2 2
December 4 4.0% 2 2
Total 99 100.0%

The months of February and January experienced the highest number of accidents (based on

average frequency), followed by September, April, May and June. The months with the lowest

average frequency of accidents are: November and December

Figure 5.2

Combined Frequency Distribution of Monthly Accidents
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5.5.1 Accident Occurrence by Day of Week

Crash occurrence data by day of week is presented in Table 5.2 and in Figure 5.3. Table5.2 also
shows accident frequency by day of week. Wednesdays had the highest number of accidents with
25 percent followed by Tuesdays with 18 percent. Reduced Sunday bus operation and less traffic
may account for the significantly lower numbers of accidents occurring on this day.

Table 5.2
Crash Occurrence by Day of Week
Month Frequency % Distribution
Sunday 1 1.0%
Monday 13 13.1%
Tuesday 18 18.2%
Wednesday 25 25.3%
Thursday 13 16.2%
Friday 13 13.1%
Saturday 13 13.1%
Total 99 100.0%
Figure 5.3

Combined Frequency Distribution of Day of Week Accidents
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5.5.2  Accident Occurrence by Time of Day

Table 5.3 and Figure 5.4 indicate data on accident occurrence by time of day. The time period
with the highest number of accidents (according to accident records where time was indicated) is
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between 2:00 p.m. - 2:59 p.m. This time segment marks LeeTran’s PM peak ridership period as
well as it being at the beginning of the PM traffic congestion period in Lee County. The second
busiest period for accident occurrence is between 3:00 p.m. - 3:59 p.m. accidents occurring in this
time period could be influenced by afternoon school traffic. The third highest period for bus
accidents occurred during 10:00 p.m. - 10:59 p.m.

Table 5.3
Combined Frequency Distribution by Time of Day
%
Time of Day Frequency | % Distribution |[Time of Day Frequency |Distribution
6:00 a.m. to 6:59a.m 2 2.02% 4:00 p.m. to 4:59 p.m. 5 5.05%
7:00 a.m. to 7:59a.m. 5 5.05% 5:00 p.m. to 5:59 p.m. 6 6.06%
8:00 a.m. to 8:59a.m 5 5.05% 6:00 p.m. to 6:59 p.m. 5 5.05%
9:00am. to 9:59a.m. 5 5.05% 7:00 p.m. to 7:59 p.m. 3 3.03%
10:00 a.m. to 10:59 a.m. 8 8.08% 8:00 p.m. to 8:59 p.m. 2 2.02%
11:00 a.m. to 11:59a.m. 5 5.05% 9:00 p.m. to 9:59 p.m. 3 3.03%
12:00 p.m. to 12:59 p.m. 5 5.05% 10:00 p.m. to 10:59 p.m. 0.00%
1:00 p.m. to 1:59 p.m. 7 7.07% 11:00 p.m. to 11:59 p.m. 0.00%
2:00 p.m. to 2:59 p.m. 16 16.16% 12:00a.m. to 5:59a.m. 1 1.01%
3:00 p.m. to 3:59 p.m. 12 12.12% Missing 4 4.04%
Total 99
Figure 5.4
Combined Frequency Distribution by Time of Day
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5.5.3  Accident Occurrence by Type of Weather

The frequency distribution for weather conditions at the time of accident is presented in Table 5.4
and Figure 5.5. LeeTran data only indicated two types of weather conditions, clear or rain. The
majority of accident records did not indicate weather type at the time of accident. The 34 records
where weather was given at the time of the accident, the majority (85 percent) of accidents
occurred in clear/sunny weather.

Table 5.4
Combined Frequency Distribution by Type of Weather
\Weather Frequency % Distribution | %o Distribution (all
(completed data) data)
Clear 29 85.29% 29.29%
Rain 5 14.71% 5.05%
Missing 65 0.00% 65.66%
Total 99 1 1
Figure 5.5
Combined Frequency Distribution by Type of Weather
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5.5.4 Accident Occurrence by Route

According to the 2002 National Transit Database (NTD) LeeTran operated a fleet of 70 buses.
LeeTran increases the bus miles and hours of operation every year beginning in mid- to late
December and going into or through the month of April. These extra miles and hours are

primarily added to routes serving the beach communities to accommodate the winter visitors

Removing the accident records where the route numbers were missing, the route which
experienced the highest number of accidents was Route 140 with 11 accidents, followed by Route
100 and Vans with 5 accidents each as shown in Table 5.5. These 3 routes accounted for a fifth
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of all accidents occurring in the study period. Table 5.5 also presents the Z-statistic for each
route. A Z-statistic greater than 1.40 can be used to identify routes that are more prone to crash
occurrence relative to the other routes in the system. This information can assist in identifying
potential problem routes with the system.

Table 5.5
Accident Frequency Distribution by Route
|Route|Frequency|% Distribution|Z-Statistic||Route  |Frequency|% Distribution|Z-Statistic
20 2 2.0% -0.0788 321 2 2.0% -0.0788
30 2 2.0% -0.0788 323 1 1.0% -0.5964
60 1 1.0% -0.5964 325 2 2.0% -0.0788
70 4 4.0% 0.9565 326 4 4.0% 0.9565
80 2 2.0% -0.0788 328 1 1.0% -0.5964
90 1 1.0% -0.5964 402 2 2.0% -0.0788
100 5 5.1% 1.4742 403 3 3.0% 0.4389
110 1 1.0% -0.5964 404 1 1.0% -0.5964
120 2 2.0% -0.0788 405 1 1.0% -0.5964
140 11 11.1% 4.5801 410 3 3.0% 0.4389
301 2 2.0% -0.0788 411 1 1.0% -0.5964
302 2 2.0% -0.0788 412 1 1.0% -0.5964
304 1 1.0% -0.5964 413 3 3.0% 0.4389
305 1 1.0% -0.5964 414 1 1.0% -0.5964
306 1 1.0% -0.5964 415 1 1.0% -0.5964
308 1 1.0% -0.5964 416 1 1.0% -0.5964
311 2 2.0% -0.0788 417 1 1.0% -0.5964
313 1 1.0% -0.5964 909 1 1.0% -0.5964
314 3 3.0% 0.4389 913 2 2.0% -0.0788
315 1 1.0% -0.5964 914 2 2.0% -0.0788
317 1 1.0% -0.5964 || Van 5 5.1% 1.4742
318 2 2.0% -0.0788 ||Shuttle 1 1.0% -0.5964
320 2 2.0% -0.0788 [|Missing 8 8.1% 3.0271
Total 99 100.00%
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Accident Frequency

Figure 5.6
Accident Frequency Distribution by Route
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Table 5.6 presents the three routes with the highest level of accidents according to their respective
accident type percentage. From this analysis, it is apparent that for two of the routes, 140 and
100, 80 percent of accidents were either sideswipe or angle. In the case for Route 140, 45 percent
were angle. Accident type was not recorded for any of the Van routes.

Table 5.6
Highest Level of Accidents by Type

Route  |% Rear End|% Sideswipe| % Angle | Unknown
140 9 37 45 9
100 20 40 40 -
Van - - - 100

5.5.5 Accident Occurrence by Impact Dynamics

Table 5.7 presents LeeTran bus impact dynamics by time period. Taking the four categories of
accidents, rear end accounted for 29 percent of accidents, sideswipe 34 percent, angle 34 percent
and other 3 percent. Our analysis indicates that there was an even split between sideswipe and

angle type of accidents. These two categories also had the highest number accidents
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Table 5.7
Accident according to Time of Day and Type

Time of Day Rear End|Sideswipe| Angle Other Total
6:00 a.m. to 6:59a.m 1
7:00 a.m. to 7:59a.m. 2
8:00 a.m. to 8:59a.m 2
9:00am. to 9:59a.m.
10:00 a.m. to 10:59 a.m. 1
11:00 a.m. to 11:59a.m.
12:00 p.m. to 12:59 p.m.
1:00 p.m. to 1:59 p.m.
2:00 p.m. to 2:59 p.m.
3:00 p.m. to 3:59 p.m. |
4:00 p.m. to 4:59 p.m.
5:00 p.m. to 5:59 p.m. 2
6:00 p.m. to 6:59 p.m.
7:00 p.m. to 7:59 p.m.
8:00 p.m. to 8:59 p.m.
9:00 p.m. to 9:59 p.m. 1
10:00 p.m. to 10:59 p.m.
11:00 p.m. to 11:59 p.m.
12:00a.m. to 5:59a.m. 1
Total 11 13 13 1
Unknown 2+59
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A cursory investigation of the time periods with the highest number of accidents according to
type reveals (excluding the unknowns), that:

e Rear end (3 accidents) occurred during the time periods of 2:00p.m.-2.59 p.m. and
3:00p.m- 3.59 p.m., which were the time periods with the 1st and 2nd highest number of
accidents overall (see Table 5.3).

o Sideswipe accidents occurred in the time periods, 10:00 a.m.-10:59 a.m. and 12:00 a.m. -
12.59 am.

e Angle type accidents occurred in the time periods, 8:00 a.m. - 8:59 a.m. and 12:00 a.m.-
12.59 a.m.

5.5.6  Accident Occurrence by Type of Involvement

The frequency distribution for bus accident occurrence by type of involvement is presented in
Table 5.8. The data clearly show that the majority (89 percent) of accidents occurred with other
motor vehicles (assuming accident record fully completed, i.e. 38 records of the 99). This was
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followed by accidents involving fixed objects, (e.g. tree) at 10 percent. Accidents involving
pedestrians amounted to zero.

Table 5.8
Frequency Distribution for Type of Involvement
Type of Involvement Rear | Sideswipe | Angle | Other Total Percent
End Frequency | Distribution

Motor Vehicle 12 9 13 34 34.3%
Fixed Object 4 4 4.0%
Pedestrian 0 0.0%
Another LeeTran Bus 0 0.0%
Parked vehicle 0 0.0%
Miscellaneous/Unknown 61 61.6%
Total 12 13 13 99 1

5.5.7  Accident Occurrence Identified by Preventability Status

The frequency distribution for preventability status is presented in Table 5.9. Only two categories

of preventability were recorded by LeeTran: preventable and non-preventable.

Table 5.9

Accident Frequency and Distribution by Identified Preventability Status

Preventability Status Frequency Percent Distribution
Preventable 32 32.3%
Non Preventable 65 65.7%
Missing/Unknown 2 2.0%
Total 99 100%

The majority (66 percent) of accidents as indicated in Table 5.9 were non preventable. Table
5.10 presents the same information according to the four general accident categories. From Table
5.10 it is evident that the majority of rear end and angle type accidents were non preventable. In
the case of sideswipe and other type of accidents, the opposite was true, i.e. the bus operator was
at fault in the majority of cases in these two categories.

Table 5.10
Percentage of Accidents by Preventability Status by Accident Type
Preventability Status | % Rear End | % Sideswipe | % Angle % Other
[Preventable 41.7% 53.8% 15.4% 29.5%
[Non Preventable 58.3% 46.2% 84.6% 67.2%
Other/Missing 0.0% 0.0% 0.0% 3.3%
Total 100.0% 100.0% 100.0% 100.0%
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5.5.8 Crash Occurrence by Years of Operator Experience

Accident data collected by LeeTran also indicates the date of hire of the operator involved. From
this information it is possible to calculate the years of experience the operator had at the time of
the accident and then determine if length of driving operation has some bearing on accident
potential. Table 5.11 presents frequency distributions of accidents with respect to length of
service at the time of accident. The first two columns present the distribution of all collision
occurrences by the operator experience categories. Columns 4 and 5 present data for preventable
crashes only. The final column illustrates the distribution of LeeTran bus operators by length of
time employed by LeeTran as at April 2003.

Table 5.11
Frequency Distribution of Crashes and Operators by Operator Experience

Years of Frequency Valid % Frequency Valid % Operator %
Experience at (Al Distribution (Preventable) Distribution Distribution
LeeTran (2003)
<lyr 5 5.1% 3 9.4% 13.2%
1 4 4.0% 0 6.6%
2 4 4.0% 1 3.1% 13.2%
3 3 3.0% 3 9.4% 8.5%
4 4 4.0% 1 3.1% 9.4%
5 7 7.1% 1 3.1% 11.3%
6 0 16.0%
7 0 0.9%
8 2 2.0% 0 2.8%
9 1.0% 1 3.1% 1.9%
10 2 2.0% 1 3.1% 3.8%
11 3.8%
12 0.9%
13 0.9%
14 0.9%
15 0.9%
16 or more 3 3.0% 4.7%
Missing 64 64.6% 21 65.6%

Total 99 100% 32 100% 100%

Due to the high number of accident records (64 percent) where the date of hire of the bus operator
in question was omitted, an analysis of accidents based on length of service of the bus operator in
question may not lead to any meaningful results. Nevertheless, based on the information that is
available the following can be inferred. From Table 5.11, operators with up to 1 years experience
were responsible for 25 percent of the accidents in the study period (where accident records were
fully completed). Operators with 3 years or less LeeTran experience accounted for more than 45
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percent of the accidents in the study period. Assessing preventable accidents only, operators with
less than 1 year of experience were responsible for 27 percent and operators with 3 years or less
experience accounted for more than 60 percent of the preventable accidents.

Even with the available number of fully completed accident records, it is possible to conclude that
the accident tendency of operators with 3 or less years of service was greater than that of their
percentage makeup of LeeTran bus operators (45 percent to 41 percent). In the preventable
accidents category, the statistics were 63 percent to 41 percent. From these cursory observations,
it is evident that LeeTran bus operators with 3 years or less of service, were involved in the
majority of accidents (of either non preventable or preventable) and may benefit from additional
training with respect to accident mitigation and prevention.

5.6 Summary of General Occurrence Characteristics

Based on a review of the frequency distributions as contained in the preceding sections, it was
determined that a ‘typical’ accident for a LeeTran bus operator during the study period:

e Occurred during the months of February or January

e Occurred on a Wednesday

e Occurred between the hour of 2:00 p.m. - 3:00p.m.

e Occurred in clear/sunny weather

e Occurred on Route 140

e Involved another motor vehicle

e Sideswipe or angle type of accident

e Non-preventable and

e Involved an operator with less than 3 years experience

5.7  Accidents per Service Mile

The lack of monthly service mile supplied information (for the study period) prohibited an
analysis write respect to accidents per service mile provided to be undertaken.

5.8  Other Factors Influencing Accident Potential

Discussions with LeeTran officials revealed a number of factors which have impacted on the
accident potential of LeeTran bus operators. A number of factors have impacted negatively in
ways similar to the other transit properties studied (see RTS section 2.8).
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5.8.1 Accident Location by Geographic Area

Geo-coding of accident data allows the identification of problem location on the LeeTran
Network. Figure 5.9 is an example 36 accidents that have been manually geo-coded to a base
map. This tool could be use to identify patterns in accident location that could be a result of
roadway configuration and signalization, traffic congestion, and bus stop location.

Figure 5.7
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CHAPTER 6 SUMMARY AND CONCLUSION

6.1 Summary

In this project, transit bus accident data from four medium sized Florida transit systems was
collected and analyzed in order to review changes in crash occurrence over time. The four
systems selected were: RTS in Gainesville, VOTRAN in Volusia County, LeeTran in Lee
County and SCAT in Sarasota. In all four cases, accident data for a minimum period of 24
months were collected from system records and analyzed.

Due to the low numbers of accidents affecting each of the four transit properties a detailed
analysis of accident data was not done. The analysis as contained in this report can be seen as
preliminary (based on the amount and detail of accident information available). Analysis of
accidents per revenue service miles supplied (undertaken in the RTS case) can provide important
information regarding bus operator levels of accident exposure. Such analysis could further be
completed on a route by route basis, but the information required (i.e. revenue service miles
supplied), has to be collected and disseminated on a regular basis. As this information is
collected and validated, it should be incorporated into accident analysis reports, at least on a
quarterly basis. The fact that detailed accident analysis is not regularly undertaken in the four
transit companies, has led to the current situation where information that could be made available,
e.g. monthly revenue service miles supplied, may not in the format that would make it user
friendly, for the staff who may be tasked with the analyzing of bus accidents.

Consistency between each transit property with respect to recording specific aspects of each bus
accident was another limitation faced during the data analysis process. It is known that bus
accidents occurring at transit properties receiving Federal funds must be reported to the Federal
Transit Administration, nevertheless, the non disclosure of accident information out of public
sight has led to inconsistency in the amount and type of data that is collected by transit properties.
For example, in the cases analyzed, some transit properties recorded the non-preventability or
preventability status of each accident while others did not. In other cases, some transit properties,
recorded the exact location where the accident occurred, with respect to the names of intersecting
streets or prominent landmark adjacent to the accident site. The lack of a minimum requirement
of accident data needs for each of the properties, resulted in the very limited level of comparative
analysis that could be performed during this study. To attempt such a comparative analysis could
prove problematic as each property had their own unique data needs and the resulting analysis
would not be comparing ‘apples’ with ‘apples.”  Accepting that the number and type of bus
accidents may be seen as a blemish on any transit property operations, the greater good that may
result from comparative analysis (through data sharing) needs to be acknowledged and
encouraged.
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6.2 Conclusion

In conclusion, based on the results of this analysis, it is apparent that a safety training program
can have a positive influence on the number and type of bus accidents in the period following the
program. The RTS case study showed this to be the case. Thus, the more training programs that
can be held (at least on an annual basis) may improve the rate at which accidents occur at a bus
agency.

One of the most enlightening aspects of this project was also encountered during an earlier study
by CUTR, an ‘Analysis of Florida Transit Bus Crashes’ (published in June 2001), involved the
process to acquire the data necessary to complete each evaluation. Thus, as mentioned earlier in
the summary section, a major shortcoming of the data collection phase was that the transit
properties only provided occurrence information that had been recorded in hard copy format (i.e.
paper based records) or incorporated into a rudimentary electronic database. This meant that, in
each case, a number of desirable variables could not be provided for analysis. It also made it
necessary for CUTR to request supplementary information that was crucial to the analyses, such
as, driver hire dates, or revenue service miles supplied (the latter variable enables account to be
made for driver exposure). Even after requests had been made, some of this information was still
not forthcoming.

Because of the data collection and analysis challenges faced during this project, it may be
beneficial to reintroduce the major recommendation of the “Enhancing Safety in Florida Transit
Systems” project that CUTR completed for FDOT in June 1998. In this project, a process to help
Florida transit agencies track and analyze their bus crashes was developed to help the systems
determine common causal factors and/or measure the success of their occurrence prevention
efforts. The process involved five basic steps that should be followed by transit agencies when
analyzing crash occurrence data and developing corrective action plans for addressing identified
problem areas. The five steps are as follows:

1. Collection of the data

2. Preparation of the data for analysis

3. Analysis of the data

4. Interpretation of the results

5. Action plan to deal with identified issues/problems

Previous reports by CUTR on transit bus crashes, have recommended that the FDOT request that
all of the Florida public transit systems collect the core set of crash occurrence characteristics that
is detailed below. The reasoning for this recommendation was that the availability of this
information on a system-by system basis would allow for not only similar analyses and
comparisons between systems, but also for a comprehensive analysis of crash occurrence
throughout the State. By FDOT requiring a minimum standard of accident reporting, future bus
accident research, analysis and interventions can become more refined to suit the unique
operating requirements of Florida Bus Transit properties.
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In the following list, those crash occurrence characteristics shown in bold are the key data
elements that would be required for most safety campaign assessments. These key characteristics
would be the minimum required data elements transit systems in creating a database from their
occurrence records. The Access Database included in this report attempts to include these key
data elements. The inclusion of the other crash data may not be necessary, it is up to the
individual systems to decide on what other elements they wish to include. These supplemental
data will only help to make any further analyses more thorough.

e Date, day of week, and time of day of occurrence

o Specific location of occurrence (on street and at street, longitude and latitude
coordinates, intersection, cross street, plaza, mall, city, or other key location identifier)

e Location of stop (near-side, far-side, mid-block)

e Roadway surface type (concrete, asphalt, brick, gravel)

¢ Road way geometry (number of lanes, configuration, posted speed, traffic control)

o Roadway conditions (wet, dry, under repair, gravel, debris)

e  Weather conditions (clear, cloudy, raining, foggy, other)

e Light conditions (daylight, glare, dawn, dusk, dark w/streetlights on, dark w/streetlights
off, dark w/no streetlights)

e Traffic conditions (light, moderate, or heavy)

e Route number, Bus Number

e Vehicle type, manufacturer, and year of manufacture

e Observed vehicle defects at time of crash (steps, floors, seats, brakes, lights) and date of last
scheduled preventative maintenance

e Operator hire and termination date (to be used to calculate years of experience at time
of occurrence)

e Operator status (regular operator, regular relief, vacation relief, mini-run, extra board,
mechanic, supervisor, service attend ant)

e Date of operator’s last refresher training course

e Occurrence impact dynamic (head on, sideswipe, angle, rear end, backing, front)

e Type of involvement (fixed object, moving vehicle, parked vehicle, pedestrian, other
bus, bike)

e Transit vehicle movement prior to/at time of occurrence (going straight, turning left, turning
right, pulling into curb or loading zone, pulling away from curb or loading zone, passing,
being passed, changing lanes, merging, sudden stop, slowing/braking, stopped in traffic lane,
stopped in loading zone, parked, backing, starting, other)

e Movement(s) of other vehicle(s) involved prior to/at time of occurrence (going straight,
turning left, turning right, pulling into curb or loading zone, pulling away from curb or
loading zone, passing, being passed, changing lanes, sudden stop, slowing/braking, stopped in
traffic lane, stopped in loading zone, parked, backing, starting, other)
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e Pedestrian/cyclist movement prior to/at time of occurrence (walking/running/riding with
traffic, walking/running/riding against traffic, stationary, working in roadway, playing in
roadway, unknown, other)

e Pedestrian/cyclist action related to location of occurrence
- Atintersection (in crosswalk, not in cross walk, no crosswalk, with sign/signal, against

sign/sign al, no sign/signal)
- Not at inter section (crossing diagonally, crossing in front of vehicle, crossing from
behind vehicle, getting in/out of other vehicle, crossing from between park ed cars, other)

e Passenger movement prior to/at time of occurrence (waiting, boarding, alighting, standing in
vehicle, moving in vehicle, sitting in vehicle, on lift, other)

e Observed condition of other driver/pedestrian/cyclist/passenger (influenced by
alcohol/intoxicated, sober, sleepy/fatigued, infirmed, wearing glasses, carrying objects, with
an observable disability, no observable disability, other)

e Contributory factors (vehicle double-parked, vehicle in crosswalk, pedestrian jaywalking,
vehicle pulled out in front, vehicle parked at angle, vehicle parked in zone , other)

e Evasive action(s) taken b y driver (hard braking, swerve, other)

o Identified preventability status of occurrence

Though the above listing may be seen as exhaustive, it can mark the start of discussions between

FDOT, bus transit systems and CUTR, as to what exactly should Florida bus transit properties
collect with respect to bus accidents affecting their operations.
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Accident Database Manual

Getting Started

To install the application from the CD on to your computer follow these steps:

Insert the CD in the CD Drive.

Go to My Compute or -> X drive (Where X is the name of your CD Drive)
Double Click CD drive on the icon. This will take you to the contents of the CD.
The file to be copied is the Access Database is called Accident.mdb.

Single click on Accident.mdb. Go to Edit->Copy and then go to the destination
drive/folder where you want to store the database on your computer.

Then Click Edit->Paste.

Follow the same procedure for user’s guide.

Click on: Start-> Programs->Microsoft Office-> Microsoft Office Access.

Click on File -> Open
Locate the access program file on your computer and
Click on the access “Accident” program-> Click on Open.
A dialog box appears, Click on Open

If a warning dialog box appears after clicking on open, ignore it and
continue to open the program.

The Main Screen
From the main screen two operations can be preformed: Data Entry, and Running Queries
and Reports.

To Start Data Entry
Click On “Open AccidentsForm” button and the accident database form will open. You are
now ready to start entering your accident data in to the database. The Accidents Form can be
used to add, delete, or modify accident records.

Note: Access automatically saves your data after you enter it into a field.

Adding a New Record
To add a new record to the existing database, click Add record button on the bottom right corner
of the form. Enter the data, and click exit. Your data is now saved.

Navigating Through Records
Each accident record will be displayed individually, and can be viewed sequentially using the
navigation buttons at the left bottom corner of the form.

Deleting a Record
To delete an accident record, click on the “Delete” button at bottom right corner of the form.
This will delete the current record, and take you to the next record in the sequence.
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Changing Data in a Record
To change data in a field go to that record using the navigation buttons. The changes you made
will be auto saved.

Exit Form
The “Exit” Button on the form will close the form, and bring you back to the main Screen.

Running Reports

On the main switchboard, click on the button “Run Queries and Reports”.

This takes you to the “Database Analysis and Report Page.”

Click on a “Report” button, the report is displayed in the “print preview” mode, ready to be
printed.

Printing Report
To print the report, Click on the “Print” button on the toolbar, or click File -> Print. To close
the report click “Quit” button the Report Screen or “Close” button on the toolbar.

Closing the Reports Screen
To close reports screen, click on the “EXit” button” at the bottom right corner. This will take you
back to the main screen.

Fields on the Form

Employee Number
This is the only way that the database can identify the employee, since all of the data is
anonymous with regard to the individuals involved in the reported incidents.

Hire Date
Employee’s date of hire. The format of the hire is: 09/02/1977 (mm/dd/yyyy).

Accident Number
Number assigned to the accident.

Month
Pull down menu that shows the month of the accident.

Date
Date of the accident. Example: 7

Year
Pull down menu of the year of the accident.

Day of Week
Pull down menu of the days of the week.

Time
This is time of the accident. The format is “HR: MM AM/PM (11:14 AM)

On Street
The Street the accident occurred on.
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At Street
The closes intersection or land mark to accident location.

City
The city the accident occurred in.

Weather
A pull down menu of weather conditions at the time of the accident. Pick the selection that
most closely matches the accident conditions.

Light
This is a pull down menu of light conditions at the time of the accident. Pick the selection that
most closely matches the accident conditions.

Impact
This is a pull down menu of impact types. Pick the selection that most closely matches the
accident circumstances.

Bus Route
Enter the name or number of the system route on which the incident occurred.

Bus Number
Enter the number of the system vehicle involved in the incident.

Road Type
Pull down menu. Pick the selection that most closely matches the road type of the accident.

Roadway Condition
This is a pull down menu. Pick the selection that most closely matches the roadway
condition at the time of the accident.

Involvement Type
Pull down menu. Pick the selection that most closely matches the involvement type.

Manufacture
Pull down menu. Pick the manufacture of the vehicle involved in the accident.

Year
Pull down menu. Pick the manufacture year of bus involved in the accident.

Traffic
Pull down menu of congestion level at time of accident.

Preventable Status
This is a pull down menu. If the accident was preventable, the box should say “PREV.” If
the accident was not preventable, the box should say “NP.”

Post Accident Testing

This is a pull down menu. If the driver was tested for drugs or alcohol as a result of the
accident, the box should say “Yes”. If driver was not tested for drugs or alcohol as a result of
the accident, the box should read say ‘No”.

75



Last Training
This is the date of the last training.

Training Type
Last training taken my employee. (Defensive driving, CDL etc;.)

Accident Description
Enter a description of the accident.

Questions

For question or assistance with Analysis of Florida Transit Bus Accidents Database contact:

Deborah Sapper
Center of Urban Transportation Research (CUTR) University of South Florida at:
sapper@cutr.usf.edu or by phone at 813.974.1446

76



77



